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COPYRIGHT NOTICE
The Visibility Modeling Tool is copyrighted software.

The VMT contains software packages subject to license agreements other than that of the Copyright
license below. Specifically the VMT utilizes:

1) JFreeChart, an "open source" library Copyright 2000-2007 by Object Refinery Limited and
Contributors. Its use is permitted in proprietary applications under the GNU Lesser General Public
License (LGPL).

2) JFreeChart is dependent upon and distributed with the JCommon library, also licensed under the
GNU Lesser General Public License (LGPL).

3) The Apache Commons project copyrighted by the Apache Software Foundation and made available
under the Apache License.

All other portions of the VMT are copyrighted under the following copyright notice.

Copyright 2004 - 2007 California Institute of Technology. Developed with U. S. Government sponsorship
under contract with the National Aeronautics and Space Administration. All Rights Reserved.

For questions or comments about this software, please email us at: help@ipac.caltech.edu or visit our
help desk: http://msc.caltech.edu/contact/help_desk.html

Permission to use, copy and distribute this software and its documentation for academic and/or research
purposes, without fee and without a written agreement is hereby granted, provided that the above
copyright notice, this paragraph and the following three paragraphs appear in all copies. Reuse of all or
part of the software contained here for commercial purposes is strictly prohibited.

The California Institute of Technology makes no proprietary claims to the results, prototypes, or systems
supporting and/or necessary for the use of the research, results and/or prototypes for academic and/or
non-profit research uses only. However, to the extent that any software and system built in collaboration
with industry partners may incorporate proprietary designs of the industry partners, it is possible that
certain restrictions may be imposed on the proprietary information

Results received from this tool are designed for non-profit, scientific or experimental purposes only, and is
an approximation based on information entered. In no event shall California Institute of Technology be
liable to any party for direct, indirect, special, incidental or consequential damages, including lost profits,
arising out of the use of this software and its documentation, even if the California Institute of Technology
has been advised of the possibility of such damage.

The California Institute of Technology specifically disclaims any warranties, including the implied
warranties or merchantability and fithess for a particular purpose. The software and documentation
provided hereunder is on an "as is" basis, and the California Institute of Technology has no obligations to
provide maintenance, support, updates, enhancements or modifications.
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1. Introduction

1.1 Purpose & Scope

The Visibility Modeling Tool (VMT) is a software application developed by the NASA Exoplanet Science
Institute (NExScl) to allow prospective or experienced users of optical interferometers to model the
interferometric observables for objects of interest using a simple interface. The VMT is a new component
on the NExScl's getCal suite of observation planning utilities. Among its primary motivations, the VMT
aims to support users of the Keck Interferometer (KI), and in particular the Nuller Key Science users.
However, it should be equally useful to users of any other ground-based interferometer. The VMT
performs visibility amplitude (and null depth in the case of the KI) predictions, and thus will help
astronomers primarily in the observation planning stage of their investigations.

At a glance, the main new capabilities of the VMT’s current release (version 2) are:

* Allows users to upload arbitrary brightness maps (in FITS format).
* Permits user data upload (in OI-FITS format) for plotting alongside models.
* Provides more realistic treatment of the Keck Interferometer Nuller beam pattern.

These capabilities extend the capabilities of the previous (version 1) release:

* All operating ground-based interferometers are supported. The user can select any baseline
or group of baselines.

* Allows the user to approximate a surface brightness of interest by combining any number of
elementary morphologies (point source, uniform disk, Gaussian disk and uniform ring).

e Each elementary brightness component can have a user-specified fraction of the total flux. If
the flux fractions in the elementary components do not add up to 1.0, the remainder flux is
assumed to be completely incoherent.

e Each elementary brightness component can have an arbitrary RA and DEC offset with
respect to the phase center.

e The disk morphologies (uniform, Gaussian and ring) can have elliptical shapes, in order to
approximate common objects of interest such as elongated stars or inclined circumstellar
disks.

* Computes visibility modulus for a composite or elementary object, or for a selected
component of a composite object.

e For the Keck Interferometer Nuller, also computes an approximated Null Depth.

*  Supports monochromatic, broadband or spectrometer visibilities.

In incremental upgrades, we envision growth of the VMT in the following main areas:

* Allow users to upload arbitrary spectra for the elementary components.

e Compute other interferometric observables, such as closure and differential quantities.
e Support of the OI-FITS data format for output of simulated data.

¢ Enable astrometric observables.

* Provide model fitting capability.
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2. Accessing the VMT via the Web

The VMT can be accessed over the web as an applet that runs in the context of a web browser. The
VMT is supported by most browsers such as Safari, Internet Explorer, and Mozilla Firefox, and is located
at: http://nexsciweb.ipac.caltech.edu/vmt/vmtWeb/.

For security reasons, the JRE does not allow applets certain privileges by default, such as access to your
computer’'s file system unless you explicitly grant it. Before you can access the applet, you will be
prompted with the option to either “Trust” or “Don’t Trust” the applet.

file://

This applet was signed by "NExScl Multi-Mission Tools," but Java
cannot verify the authenticity of the signature's certificate. Do

7 you trust this certificate?
&)
Click Trust to run this applet and allow it unrestricted access to your
computer. Click Don't Trust to run this applet with standard Java
restrictions.
(?) [ Show Certificate ) ( Don't Trust ) | Trust

To allow the applet full access to your file system, you must grant it access by selecting the “Trust” option.
Selecting the “Don’t Trust” option will still bring up the applet interface, but you will not be presented with
dialogue boxes to browse your file system when attempting to load or save files.

After responding to the certification dialogue, the “Start VMT Applet” button will appear on the browser
page (may take a few moments). Pressing the “Start VMT Applet” button starts the downloading process
of the applet to your local machine. The process consists of 3 steps:

1) the applet gets downloaded to your local machine,
2) the JRE (Java Runtime Environment) is started up on your machine (if not already running)
3) the JRE starts up the application.

Downloading the applet for the first time (or when an updated version is deployed on the server) will take
a few moments. If a red X appears in the applet button on the web page, your machine either does not
have Java installed, or your browser is not configured correctly to run the applet (i.e. requires a plugin).

The VMT requires JRE version 1.4 or higher. To test your machine’s configuration for compatibility with
the VMT, there are websites that can help such as www.javatester.org. This web site addresses four Java
issues:

1
2
3
4

Is your web browser Java enabled?

If so, what version of Java is it using?

How to install and upgrade Java, and
Configuring the Java options in your browser.

~— — ~— ~—
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3. Downloading the VMT Executable

The VMT can be downloaded as an executable JAR (Java Archive File) file within a .zip file from the
NExScl download site at http://nexsciweb.ipac.caltech.edu/software/. For assistance with accessing the
download site, please use our help desk web form at http://nexsciweb.ipac.caltech.edu/cgi-
bin/helpdesk/helpdesk.cgi

Your computer must have a compatible Java Runtime Environment (JRE) version installed (1.4 or
higher). You can check your java version at www.java.com and download the appropriate version if
necessary.

Downloading and Installing JAI:

To upload images, your Java system must be extended with the Java Advanced Imaging (JAI)
application interface (API) which supports image manipulation for Java applications and applets. To
download JAI, go to http://java.sun.com/products/java-media/jai/current.html For specific installation
instructions, click the “Documentation” link under the “Reference” heading on the left side of the page.

Once a compatible version of Java is installed on your computer:
1] Locate and click the "download" link next to VMT Tool
2] Then, depending upon your platform:

MacOSX:

a) save the vmtx-y.zip file to a desired location on your machine

b) locate the zip folder on your machine and extract it (double-click). Your version of MAC OS may
do this step automatically.

c) locate the executable jar icon (vmt-x.y.jar) within the unzipped folder and double-click it.

Windows:

a) save the vmt-x.y.zip file to a desired location on your machine

b) locate the zip folder on your machine, and extract it (right click->Extract All..)

c) locate the executable jar icon (vmt-x.y.jar) within the unzipped folder and double-click it.

Linux:

a) save the vmt-x.y.zip file to a desired location on your machine

b) locate the zip folder on your machine, and extract it (right click->Extract Here)

c) in terminal window, locate vmt-x.y.jar executable jar file within the unzipped folder
d) launch it from the command line: java -jar vmt-x.y.jar

To start your first VMT session, the VMT Session File example can be read into the executable under the
"File->Read VMT Session File" menubar pull-down found in the upper-left-hand-side of the control panel.
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Increasing JVM Memory:

Upon startup, the initial memory allocated to the application by the JVM may not be sufficient enough for
processing large (large than 512x512 pixels) images. If you are attempting to load a large image and
encounter an “Out of Memory” message, you will have to exit the VMT and restart the JVM with a
parameter directing the JVM to allocate more memory to the application.

The steps to increase VMT memory varies according to platform you are using:

MacOSX:

a) Exit out of the VMT application

b) Open a terminal window (Applications->Utilites->Terminal.app) to get a command line prompt.
Locate the vmt jarfile and enter:

java —Xms128m —Xmx256m —jar location/vmt.x.y.Jjar

Windows:

a) Exit out of the VMT application

b) Open up the Windows Control Panel

c) Locate the Java Control Panel and double-click

d) Select the “Java” Tab

e) Click the first “View...” button

f) Add -Xms128m and -Xmx256m to the Java Runtime parameter for each JVM listed in the Java
Runtime Settings dialog.

g) Click OK to close the panels

h) Restart the VMT application

Linux:

a) Exit out of the VMT application

b) Open a Linux terminal window to get a command line prompt, locate the vmt jarfile and enter:
java —Xmx256m —jar location/vmt.x.y.jar

c) Restart the VMT application

KNOWN ISSUE(S):

1] VMT sessions which contain uploading sequential large images may cause the VMT to indicate that
the VMT has run out of memory. If the image is larger than 512x512 pixels, make sure the memory has
been increased (see section “Increasing JVM memory for your platform). If the image is 512x512 pixels
or less, the VMT may be in a state in which the Java Runtime Environment needs to be exited and
restarted.

Workaround:
For the VMT application, simply exit the VMT and restart it. If you are using the VMT applet, under the
pull down menus, there is a “Exit Java” option under the Help pull down menu.
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4. Using the VMT

4.1 Overview

The Applet and downloadable executable user interfaces are identical in their layouts. The VMT GUI
layout has three main components:

1. Controls on left side of the GUI that allow the user to specify the interferometer, baseline, and
target to be simulated.

2. Controls on the right side of the GUI that allow the user to select which observables are to be
displayed and the time cadence of the simulation.

3. Main display in the center of the GUI for viewing the predicted simulated observables (both in
graphical and textual formats) and summary information about the target and instrument being
simulated. Tabs at the top of this display also allow the user to customize the control panels to
the user’s preference, and to access help via an application index.

1. The left control panels are made up of the following sub control panels:

* Mode Selection Panel (“Analytical Models” or “Image Upload”)
* Site/Baseline Selection Panel
¢ Target Model Parameter Panel
* In “Analytical Models” mode:
e Target Model Components Panel
* Single Component Parameter Panel
* In“Upload Image” mode:
* Image Upload Parameter Panel
* Image upload button and image display

2. The right control panels are made up of the following sub control panels:

* Plot Content Selection Panel
¢ Wavelength Parameters Panel
e Observing Parameters Panel
* Instrument Parameters Panel

3. The middle display panel includes the following tabs:

* In “Analytical Models” mode:
o Plot: shows a line plot with X & Y axis quantities determined by choices in the Plot
Content Selection Panel (see 2 above).
o Simulated Data: simulated data in ASCII format.
Instrument: Summary of the instrument and observing parameters chosen.
Model: description of the target model constructed.

* In“Upload Image” mode:
o Plot: Same as above.
o Simulated Data: Same as above.
o Instrument: Same as above.

10
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FITS: Shows header and displays image data in user uploaded FITS brightness image.

o Image: Displays the user uploaded FITS brightness image.
2D Vis Modulus: Displays the 2D visibility of the user uploaded FITS brightness image,
with overlaid u & v points corresponding to the interferometer and observing parameters
chosen.

o Nuller Response (for Kl only): Displays the 2D “beam pattern” of the Kl Nuller, including
an option to overlay the target brightness image.

o OI-FITS (only if an data file has been uploaded): shows headers and data in user
uploaded data file in OI-FITS file.

Visibility Modeling Tool (VMT)

NASA Exoplanet Science Institute. .

w T California Institute of Technology

- - - % -

File Settings Help

rMode Selection—————————— | "piot | Simulated Data | Instrument | Model | rPlot Content Selecti
Mode: [ Analytical Models v | Visibility Squared vs Hour Angle Y Axis: ’ Visibility Squared v ‘
Site:KECK Target:UniformDisc-001
rSite/B i i «K1K2 X Axis: ’ Hour Angle v ‘
Site KECK  ~| :;i Model: ‘ Single Component f=1.0 v ‘
Baseline(s): K1K2 1.00
rTarget Model Parameters 0.95 I;;; Include: .AII A's v ‘
Declination (degs): [+45.0 | ::“ g% g Raranetar
Target Model Components: O'B; %% Option: Spectrometer L 4
UniformDisc-001 ; i If
Gaussian-002 U iiiif
‘ UniformRing-003 0.70 I I I - Dl 1)
ectral Band: 11 - 1. v
I aaa | oo || Bow Ly p podks
|Incoherem Flux Fraction = 0.00 § 0.60 II I II Lower Limit (um): |1.35
rSingle Component Parameters — ‘g. 0.55 i I{ II Upper Limit um): |1.95
Target Type: [Uniform Disc || 2 0.50 I { {
S 045 I I { i Channels: 3 ‘
Name: |UniformDisc-001 At II II If i ——
: -Observing Parameters —————————————
Flux Fraction: 0.7 035 7 iII Iiif{ IIII serving aram» ers
Major Axis Diam (mas): [3_0 | 0.30 II IIE EIEEIIIII{IE Ii HA Before Transit (hrs): |-6.0
0.25 i f HH HH{ I HA After Transit (hrs):  |6.0
Minor Axis Diam (mas): [0.25 :j“ IIiIH 111 i i HA Increment (mins): ’15.0
Major Axis PA (d ;120 s
R 0.10 IIIIIIIIIIII rInstrument Parameters ——————————————
RA Offset (mas): o |
Dec Offset (mas): 0.0 ::; VEError: 0.02
i 5 5 4 3 2 A 0 1 2 3 4 5 8 X ]
Reset ‘ AT GRS Null Depth Error: |5.0E-4 ‘

Visibility Modeling Tool GUI Layout

Each of the sub panels is described in further detail in subsequent sections. The center display panel is
composed of many tabs allowing the user to select various options to view the calculated observables in
both graphical and textual formats. The Preferences Tab allows the user to modify the layout of these
control sub panels.

4.2 Starting the VMT

In order to begin using the VMT, a target model must first be created (or read in from a .vmt disk file if
previously created and saved to disk, or uploaded from a FITS file containing a brightness image). The
default behavior for the VMT is to start up in Analytical Model Mode. The observables are immediately
displayed in the center plot tab based upon the initial default settings of the control panels. Upon
modification of various parameters within the control panels, the resident model is immediately

11



recalculated and it observables displayed. The functionality of these control panels is described in the

subsequent sections.

4.3 File Pulldown Menu

The VMT pulldown menu items consist of “File”, “Settings”, and “Help”. The “File” Pulldown Menu Option
allows the user to restore a previous VMT session by loading in a VMT session file (VMT session files
have a .vmt extension), save the current VMT sessions, save the predicted simulation data to a file, read
an OI-FITS file to overlay the current simulated data and exit the VMT application.

VMT-2.0 User’s Guide

v

File | Settings Help

Read YMT Session File
Save YMT Session File

Save Prediction Data

Read OI-FITS File

Exit

The “Settings” option allows the user to set system settings and user preferences.
Preferences” section contains a checkbox which allows the user to flip an uploaded image to orient it to

the VMT assumed orientation “east is left’”. The Look and Feel of the overall GUI is also available to be

set.

rSettings and Preferences

1
Baseline(s): K1K2

[Tl

4

NASA Exoplanet Science Institute

rSystem Settings

Image Orientation: [_| Flip Image Right/Left

OI-FITS Data

eft Right Up

Reset Control Panel Configuration

Look and Feel: Default ﬂ
rControl Panel Preferences
Mode Selection ® Left ORight ( Up ) ( Down ) O Hide
Site/Baseline Selection @ Left O Right ( Up ) ( Down ) O Hide
Target Model Parameters @ Left () Right ( Up ) ( Down ) O Hide
Target Model Components @ Left () Right ( Up ) ( Down ) O Hide
Component Parameters @) Left () Right ( Up ) ( Down ) (O Hide
Image Upload Parameters Left Right Up Doy de
Plot Content Selection O Left @ Right ( Up ) “Wg O Hide
Instrument Parameters O Left @ Right ( Up ) ( Down ) O Hide
Wavelength Parameters O Left ® Right ( Up ) ( Down ) O Hide
Observation Parameters () Left @ Right ( Up ) ‘\W,r O Hide

Close Settings and Preferences Window

The “Control Panel Preferences” section allows the user to customize the configuration of the sub control
The placement of each sub panel can be customized by
moving it to the left or right side of the GUI, moving it up or down within either the left or right control

panels in the left and right control panels.

12
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panel, or hiding it from the GUI altogether. The initial default configuration for the Control Panel can be

VMT-2.0 User’s Guide NASA Exoplanet Science Institute

restored by pressing the “Reset Control Panel Configuration” button.

The “Help” option provides help for using the VMT in which the user can select from a list of topics in the

“Select Help Subject:” pull-down menu.

Also under the “Help” option is an “About” tab that provides information regarding the VMT application,
it's environment as well as third party software (and their licenses) that it incorporates.

~VMT Help

Select Help Subject: | Instrument Parameter Panel

Instrument Parameter Panel

The Instrument Parameter panel enables the user to specify the parameters
specific to an instrument, 1.e. at this time the characteristic errors in V2 or null
depth. These errors are applied to all the simulated data, to facilitate comparison
of simulated data with changes in the visibility curves as the model parameters
change.

Wavelength Parameter Panel

The Wavwelength Parameter panel allows the user to select among several spectral
options. Because currently we only support grey surface brightness, these options
only affect the spatial frequencies {(u and v). The options include a
monochromatic calculation at the user specified center wavelength (in ticrons),
broadband calculation in a user specified spectral band (defined by the upper and
lower limits in microns) and a spectrometer option specifying a number of
spectral channels within a band.

but also provide a list of common astronomical bands. At this titne these bands
are all assumed to have a top-hat shape.
Observation Parameter Panel

The Observation Parameter panel enables the user to define the observation time

3 £ mboact cund cand LI A A 1 it 1

For the broad bands, we allow the user to select any lower and upper wavelength,

<

Full User's Guide at http: /iwww.mscweh.ipac.caltech.eduirmtiymtiweb
For guestions, comments or bugs, please visit our help desk at:
http: imsc.caltech.eduicontacthelp_desk.html

| Close Help Window

4.4 Control Panels

4.4.1

Mode Selection Panel
The user can establish a target model by either selecting “Analytical Model”, or “Upload Image” in the

“Mode Selection Panel”.

In the “Analytical Model” mode, the VMT provides the “Single Component Parameter” panel that supports
the creation of the single component brightness models (point source, uniform disk, Gaussian or uniform
disk), as well as the “Target Model Component Parameter” panel that allows the creation of linear
combinations of these elementary components. Upon starting up the VMT, a default target is selected

Mode Selection

Mode: ’ Analytical Models ¥ |

|—SiteJBase Upload Image _l

13
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(initially a uniform disc, but can be changed), with parameters initialized to zero. The user can then
modify these values via the Single Component Parameters panel, select a different component from the
Target Type pull-down menu, or construct a composite model using the “Add” and “Delete” buttons in the
Target Model Components Panel. In the case of a composite model, the observables plotted correspond
to the currently highlighted component in the list or to the global model, via plotting controls described
later in this manual.

In the “Upload Image” mode, the VMT displays the “Upload Image” panel. This panel supports the
uploading of arbitrary brightness models from a FITS formatted file specifying an image of the object of
interest and a specification of the image pixel scale (i.e. milli-arcsec/pixel). The VMT does not attempt
to read the pixel scale or image orientation from the input FITS file. This panel is further described in
the following sections.

4.4.2 Site/Baseline Selection Panel

The Site/Baseline Selection panel allows the user to select an interferometer location and it's associated
baseline(s). The currently supported interferometers are KECK, PTI, NPOI, CHARA, VLTI and SUSI.

Site/Baseline Selection

Site: PTI v
NS

Baseline(s): NW
SW

Upon selection of an interferometer, all associated baselines are displayed in the “Baseline(s)” list. The
first baseline in the list is selected as the default. The user can select any baseline in the list, a contiguous
subset of baselines, or all the baselines by clicking on any baseline, holding down the Shift key and
selecting another baseline. Each baseline plot can be either displayed or hidden by holding down the
Control key and clicking on the desired baseline in the menu. All selected baselines are plotted
simultaneously on the “Plot” tab in the center display panel.

NOTE: Nulling observables are only enabled and calculated for the Keck Interferometer.

4.4.3 Target Model Parameter Panel

In “Upload Image” mode, the Target Model Parameter panel allows the user to specify parameters that
apply to the composite model as a whole, i.e. the phase center declination only at this time.

4.4.4 Single Component Parameter Panel

In “Analytical Mode”, the Single Component Parameter Panel enables the user to enter/modify
parameters for each target type. The user can select one of the morphologies using the “Target Type”
pull-down menu. The panel will configure itself to allow the user to enter/modify the relevant parameter
values specific to that morphology.

14
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~Single Component Parameters —

Target Type: |UniformDisc ¥

Name: [UniformDisc-Dm |

Flux Fraction: 07
Major Axis Diam {(mas): 3.0

Minor Axis Diam (mas): (0.25
Major Axis PA (degs): [12.0

RA Offset (mas): 0.0
Dec Offset (mas): 0.0
Reset ‘

The tool currently supports four morphologies: Point Source, Uniform Disc, Uniform Ring, and Gaussian. .

Parameters common to all of the component morphologies are:

Name specifies the name of the model component and can be any string of up to 20
characters

RA Offset specifies the component’s Right Ascension offset with respect to the phase center
(milliarcseconds)

Dec Offset specifies the component’s Declination offset with respect to the phase center
(milliarcseconds)

Flux Fraction specifies the component’s fractional contribution to the total flux

NOTE: the sum of the flux fractions assigned to all components in a composite model must be less than
or equal to 1.0. If the sum of the flux fractions is less than 1.0, the remainder flux is assumed to be

completely incoherent.

The non-point source morphologies (i.e. Uniform Disk, Gaussian, and Uniform Ring) contain additional
parameters that describe their size and shape:

Uniform Disk and Gaussian:

Major Axis Diameter specifies the angular diameter of the major axis (milliarcseconds)

Minor Axis Diameter specifies the angular diameter of the minor axis (milliarcseconds). This is
different than the major axis diameter for elliptical morphologies.

Major Axis Position Angle specifies the orientation of the elliptical brightness distribution, via the
position angle of the major axis, measured East of North (degrees)

Uniform Ring:

Major Axis Inner Diameter  specifies the ring inner angular diameter along the major axis
(milliarcseconds)

Major Axis Outer Diameter specifies the ring outer angular diameter along the major axis
(milliarcseconds)

Minor Axis Outer Diameter specifies the inner ring angular diameter along the minor axis
(milliarcseconds). This is different than the major axis outer diameter for
elliptical morphologies.
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Major Axis Position Angle  specifies the orientation of the elliptical brightness distribution, via the
position angle of the major axis, measured East of North (degrees)

The “Reset” button allows the user to cancel all the modified target parameters of the selected target and
revert all parameters to the values they were in upon initially selecting the target for modification (or in the
case of adding a target, to the original default values).

4.4.5 Target Model Components Panel

The Target Model Component Panel lists all of the components currently defining a composite. It also
tracks the total fractional flux, and assigns any remaining flux as a completely incoherent component. The
component that is highlighted is the one displayed in the “Single Component Parameters” panel and can
be modified simply by changing any of the values. The changes are immediately saved and reflected in
the data output and plots.

To delete a target in the model, select it from the Target Component Model list and press the delete
button. The deletion is immediately reflected in the composite model and cannot be undone.

Additional target components can be added by pressing the “Add” button on the panel. This causes a
new default target component to be added to the composite model and displayed in the “Single
Component Parameters” panel. The user can then modify the added target component.

-Target Model Components
UniformDisc-001
Gaussian-002
UniformRing-003

Add ” Delete
Incoherent Flux Fraction = 0.20

NOTE: Optical interferometers require fringe tracking on a bright compact component, which effectively
becomes the phase center. It is the user’s responsibility to construct a composite model that satisfies this
requirement. Also, real interferometers have field of view limitations, and the user must be mindful of this
when constructing a very extended object or one that contains components placed at large RA and DEC
offsets.

4.4.6 Upload Image Panel

The user can bring up the “Upload Image” panel by selecting the “Upload Image” option in the “Mode
Selection” panel. The panel allows the user to upload an arbitrary brightness image by selecting a FITS
file from the users local disk. The panel displays a “No Image Available” message (Figure A) until the
user successfully selects and reads a FITS image from a FITS-formatted file.
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-Image Upload Parameters rimage Upload Parameters I Upload Parameters
K1 Mode Selection
Pixel Scale {mas/pixel): [1.0 Pixel Scale (masipizel): 10 | ) V* Mode

‘@ Nuller Mode

I |

[_] Suppress Null Calculation

No

Pixel Scale (masipixel): [1.0 |

Image
Available
Upload FITS Image ‘ ’ Upload FITS Image ’ [ Upload FITS Image I
Figure A | Figure B Figure C (Kl only)

Pressing the “Upload FITS Image” button brings up a file selection dialog box that allows the user to
browse for the FITS file to be uploaded. The “No Image Available” message is then replaced by the
uploaded brightness image (figure B). The user must specify the pixel scale of the image by entering it
(in units of milli-arcsec/pixel) in the Pixel Scale input box.

NOTE: the FITS format supports some standard, but optional, keywords to specify the image plate scale
and sky coordinates. However, the VMT does not require the presence of these optional keywords; in the
current version, it does not read them even if they are present. The pixel scale must be entered by the
user in the Pixel Scale input box, as described above, and the image orientation is assumed to be: East =
Left, North = Up. The input image can also be flipped left-to-right via a checkbox in the Preferences tab.

Currently, the VMT is limited to uploading FITS images of at most 512x512 pixels in size, unless the JVM
memory is increased as described above. If an uploaded image does not have a number of pixels that is
a power of 2, the VMT will zero-pad around the input image to the nearest power of 2.

When the Keck Interferometer is selected, the Image Upload Panel displays a Kl Mode Selection Panel
(figure C) in which the user can select either of two modes, the visibility mode (V2 Mode”) or the Keck
nuller mode (“Nuller Mode”).

In Visibility (V2) Mode, the VMT:

1] disables the Null Depth observable option in the Plot Tab.

2] disables the Null Depth Error field in the Instrument Parameter Panel.
3] sets the Null Depth data to “null” in the Simulated Data Tab.

In Keck Nuller Mode, the VMT:

1] disables the Visibility Modulus and Visibility Squared observable options in the Plot Tab.
2] may modify parameters in the Wavelength Parameters Panel valid to Kl Nuller Defaults .
3] disables the Visibility Squared Error field in the Instrument Parameter Panel.

4] sets the Visibility Squared data to “null” in the Simulated Data Tab.

Because the Nulling observables for the Keck Interferometer require a time consuming calculation, a
suppression option is also provided in this case. When selected, all subsequent nuller calculations are
suppressed. When deselected, the nuller calculation is immediately calculated and for each subsequent
modification to any control panel input. A progress bar is provided to inform the user of the progress of
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the nuller calculation. The length of the nuller calculation is dependent upon the number of hour angle

observation points specified and number of spectral channels.

nuller calculation is quicker.

4.4.7 Plot Content Selection Panel

The “Plot Content Selection” panel allows the user to select the content of the displayed observables.

This panel is enabled only when the Plot Tab is displayed.

-Plot Content Selection

X Axis: [ Hour Angle

Y Axis: ’ Visibility Squared a4 ‘
|
Model: ’ Single Component f=1.0 A4 ‘

Include: |AllA's

4471 Observable Selection

The “Plot Content Selection” panel allows the user to customize the plot content by selecting one of the

following observables on either axis:

Visibility Squared

Visibility Modulus

Null Depth (for Kl only)

Baseline Length (in meters)

Baseline Length (in millions of wavelengths)
Hour Angle

U Coordinate (in meters)

U Coordinate (in millions of wavelengths)
V Coordinate (in meters)

V Coordinate (in millions of wavelengths)
Position Angle (in degrees)

Zenith Angle (in degrees)

Wavelength (in microns)

-Plot Content Selection

Y Axis: Visibility Squared

X Axis: |Vvisibility Squared
Visibility Modulus
Model: Baseline Length (m)
Include: |Baseline Length (MA)
Hour Angle
“Waveleng{U Coordinate (m)
U Coordinate (MA)

- . |V Coordinate (m)
option: |/ Coordinate (MA)
| Position Angle
Zenith Angle
Spectral Melen_?_th

I —

For details on the algorithms employed to calculate these observables, please refer to Appendix B.
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4.4.7.2 Model Selection

In “Analytical Models” Mode, the “Model” selection pulldown menu in the Plot Content Selection panel,
allows the user to select one of three options to view the observables:

Single Component computes and displays the selected observables for the component currently
highlighted in the Target Model Components panel described earlier, using
the fractional flux that was entered by the user.

Single Component f=1.0 same as above, but places all the flux in this component,

Composite displays the calculated observables for the composite model.
In “Image Upload” Mode, the “Model” selection is automatically set to “FITS Image”.

4.4.7.3 Other plotting options

In order to improve the readability of the plots, when the user specifies the spectrometer option in the
Wavelength Parameter panel (see 4.4.9 below), the VMT provides the user an “Include” option to plot the
selected observable for all the spectrometer wavelengths or for only the middle wavelength. Likewise, if a
plot as a function of wavelength is selected, the user has the option to plot the selected observable for all
the hour angle samples, the first hour angle sample, the middle hour angle sample, or the last hour angle
sample.

4.4.8 Instrument Parameter Panel

The Instrument Parameter panel enables the user to specify the parameters specific to an instrument. In
this version of the VMT these are the characteristic errors in V or null depth. These errors are applied to
all the simulated data to facilitate comparison of simulated data with changes in the visibility curves as the
model parameters change.

Instrument Parameters

\* Error: [0.02 ‘
Null Depth Error: |5.0E-4 |

4.4.9 Wavelength Parameter Panel

The Wavelength Parameter panel allows the user to select among several spectral options. Because we
only support grey surface brightness at present, these options only affect the spatial frequencies (u and
v). The options include a monochromatic calculation at the user-specified center wavelength (in
microns), broadband calculation in a user specified spectral band (defined by the upper and lower limits
in microns) and a spectrometer option specifying a number of spectral channels within a band.

-Wavelength Parameters
Option: ’ Spectrometer - ‘
Spectral Band: ’ J v

Upper Limit (um): |1.39

|
Lower Limit (um): [1.11 |
|
l

Channels: ]3
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For the broad bands, we allow the user to select any lower and upper wavelength, but also provide a list
of common astronomical bands. At this time these bands are all assumed to have a top-hat shape.

4.4.10 Observation Parameter Panel

The Observation Parameter panel enables the user to define the observation time span, in terms of start
and end Hour Angle, and sampling interval.

-Observing Parameters

HA Before Transit (hrs): ]-6.0
HA After Transit (hrs): \a.o
HA Increment (mins): ’1 5.0

4.4.11 Calibrated Data Overlays (OI-FITS)

The VMT provides the user with the capability to overlay calibrated data in the OI-FITS format (an IAU
standard, see http://www.mrao.cam.ac.uk/research/OAS/oi_data/oifits.html). The “Read OI-FITS File”
under the File Pulldown Menu will prompt the user to browse for an OI-FITS formatted file and will parse
and overlay the data in the vis and vis® data tables associated with each (details are further described in
subsequent sections).

4.5 Display Tabs

The VMT has a center display panel that consists of a number of tab options which allow the user to view
the predicted simulated observables (both in graphical and textual formats), summary information about
the target and instrument being simulated, and to customize the control panels to the user’s preference.

4.5.1 Plot Tab

The plot tab allows the user to view the simulated observables in a plot or graphic context. The user
controls the content of the plot in the “Plot Content Selection” panel described in Section 4.4.7.
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"| Plot | Simulated Data | Instrument | Model |
Visibility Squared vs Hour Angle
Site:PTl Target:UniformDisc-001
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The plot contains many default settings that can be customized by right clicking on the plot. The user can
customize properties such as the title’s text, font and color, the plot axes text font, color and range
settings, and the plot lines, types, and colors.

45.1.1 “Properties” Option

The “Chart Properties” panel can be brought with a right mouse click on the chart and selecting
“Properties...”. This panel contains the tabs “Title”, “Plot” and “Other”.

The “Title” tab allows the user to modify the properties of the chart’'s main title such as the name, the font
and color of the title.

The “Plot” tab allows the user to modify the properties of the plot. These properties include the same
properties of the main chart title (name, font and color), but for each of the domain and range axes labels.
The user can select the “Domain Axis” or “Range Axis” tabs to scale the plot and/or customize the tick
mark properties for either the domain or range axes, respectively. The “Appearance” tab allows the user
to modify the appearance of the plot including the thickness of the plot line(s), the plot’'s background color,
and plot orientation (vertical or horizontal).

The “Other” tab allows the user to choose whether or not the fonts of the chart are “anti-aliased” relative
to the background color of the chart.
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45.1.2 “Save” and “Print” Options

The “Save as...” and “Print...” options allow the user to save and print the chart in the downloaded
executable version of VMT.

4513 “Zoom In” and “Zoom Out” Options

The “Zoom In” and “Zoom Out” options allow the user to zoom in or out on the plot for either the range
and/or domain axes. The user can also zoom in on the data by left clicking and dragging over a subset of
data points to be expanded in a top left to bottom right motion. Dragging the mouse in any of the three
alternate ways (top right to bottom left, bottom right to top left or bottom left to top right) causes the data
to be re-centered.

4514 “Auto Range” Option

The “Auto Range” option turns the automatic scaling feature to be turned on. The right-click->"Auto
Range” option is simply a short cut for going through the chart “Properties...” option. To reset the scaling,
the user must right mouse click and select "Properties->Plot->Range/Domain Axis”.
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4.5.2 Simulated Data Tab

The “Data” tab provides an ASCII textual representation of the calculated observables in a tabular format.
The downloadable version of the VMT provides the capability to save this data in a text file (in the Menu
Bar select File->Save Prediction Data). The format of the data file allows for the easy importing into other
programs for manipulation. In future releases, we plan to export data also in the IAU standard for optical
interferometry (OI-FITS).

((Plot | Simulated Data | Instrument | Model |
-Text Data
Site:PTI Target:UniformDisc—-001

Hringle Baseline U(m) ¥{m) Bp(m) Za(deq) PA{deq) ¥2(1.65)
-6.00 N3 -59.553 -54.559 80.766 74.042 227.506 0.40099
-6.00 NW -18.108 21.912 28.426 74.042 320.431 0.93912
-6.00 3V 41 .445 76.468 86.978 74.042 28.457 0.21629
-5.75 N3 -61.853 -56.546 83.804 71.202 227.566 0.37255
-5.75 NV -23.411 21.233 31.606 71.202 312.207 0.94998
-5.75 S¥ 38.441 77.776 86.757 71.202 26.301 0.21056
-5.50 N3 -63.888 -58.604 86.695 68.325 227.470 0.34477
-5.50 N¥ -28.615 20.381 oo alE 68.325 305.461 0.96049
-5.50 3V 35.273 78.983 86.501 68.325 24.065 0.20606
-5.25 N8 -65.649 -60.724 89.428 65.415 227.232 0.31786
-5.25 N¥ -33.696 19.361 38.862 65.415 299.882 0.97029
-5.25 B8V 31.954 80.083 86.223 65.415 21.752 0.20277
-5.00 N3 -67.130 -62.898 91.992 62.474 226 .864 0.2%9203
-5.00 NV -38.632 18.178 42.695 62.474 295.198 0.97898
-5.00 S¥ 28.498 81.073 85.935 62.474 19.367 0.20067
-4.75 N3 -68.323 -65.115 94.382 59.506 226.377 0.26742
-4.75 NV —-43.403 16.835 46.554 59.506 291.200 0.98620
-4.75 3V 24.920 81.947 85.652 59.506 16.914 0.19974
-4.50 N3 -69.223 -67.366 96.592 56.513 225.779 0.24417
-4.50 NV —-47.989 15.339 50.381 56.513 287.726 0.99157
-4.50 3W 21.235 8z.702 85.385 56.513 14.401 0.19999
-4.25 NS -69.827 -69.642 98.620 53.497 225.07¢ 0.22239
-4.25 NV -52.369 13.696 54.130 53.497 284 .656 0.99474
-4.25 3V 17.459 83.336 85.145 53.497 11.833 0.20140
-4.00 N3 -70.132 -71.933 100.464 50.461 224.274 0.20213

4.5.3 Model Tab

The “Model” tab (“Analytical Models”
model constructed by the user.

mode only) provides a list of all the parameters describing the target

( Plot | Simulated Data | Instrument = Model |

~Target Model Summary
Target Target Flux Major Minor InnerRing Major RA Dec
Name Type Fraction AxisDiam AxisDiam AxisDiam  AxisPA Offset Offset
UniformDisc-001  UDisc 0.7 3.0 0.25 N/A 12.0 0.0 0.0
Gaussian-002 Gauss 0.2 1.0 0.3 N/A 28.0 10.0 10.0
UniformRing-003  URing 0.1 0.25 0.1 0.05 43.0 3.4 il 7
component-002 Uninit N/A N/A N/A N/A N/A N/A N/A
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4.5.4 Instrument Tab
The “Instrument” tab provides a summary of the selected instrument configuration.

(Plot | SimulatedData | Instrument | Model |
~Instrument Summary

INTERFEROMETER :

Name PTI
Latitude (degs) 33.3567000
BASELINE(S):

Name East North Up
N3 —-37.116 -103.265 3.319
NW —81.685 —28.214 3.106
SV —-44 . 566 75.049 -0.214

INSTRUMENT PARAMETERS:
Visibility_Squared_Error 0.02000

WAVELENGTH_FPARAMETERS:

Wavelength Option Spectrometer
Band_Lower_ Limit il . S5
Band Upper_ Limit 1.95
Number Of Channels 1
OBSERVATION PARAMETERS:

Hours_Before Transit —-6.00
Hours_After Transit &.00
Minute_ Increments 15.00

TARGET_MODEL_PARAMETERS:
Declination (degs) +30.0

4.5.5 FITS Tab

The “FITS” tab (“Upload Image” mode only) provides an interface to view the contents of the uploaded
FITS file that contains the arbitrary brightness image. Both the primary header and image itself can be
viewed by selecting the appropriate sub-tab. The FITS Raw Image tab provides a contrast slider control.
The displayed image is first “‘gamma corrected”, meaning the pixel values are raised to the power of
1/gamma; then it is scaled so that the smallest real pixel value corresponds to the smallest integer or byte
value, and the largest real value corresponds to the largest integer or byte value.

[ Plot | Simulated Data | Instrument | FITS | Image | 2D Vis Modulus |
0.PRIMARY (IMAGE) |

PRIMARY

( Header | RAWIMAGE |

SIMPLE = T / Written by IDL: Fri Aug 15 12:41:11 2008
ITPIX = -64 / Number of bits per data pixel

AXTIS = 2 / Number of data axes

A¥XIS1 = 512 /

AXISZ = 51z /

XTEND = T / FITS data may contain extensions

ATE = '2008-08-15" / Creation UTC {CCCC-INI-DD) date of FITS header

OIMENT FITS (Flexible Image Transport System) format is defined in 'Astronony
OIMENT and Astrophysics', wolume 376, page 359; bibcode 2001A8A...376..359H
ND
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4.5.6 OI-FITS Tab

The “OI-FITS” tab (available in either mode but only when OI-FITS data exists) provides an interface to
view the contents of a user uploaded OI-FITS file. All file extensions and tables are read in and a
corresponding sub-tab is created to allow the user to view any extension of interest.

For a description of the OI-FITS format (an IAU standard) we refer the reader to:
http://www.mrao.cam.ac.uk/research/OAS/oi_data/oifits.htmlh

To read in an OI-FITS file, the operator selects “Read OI-FITS File” from the File pulldown menu. The
visibility data (from the OI_VIS tables) and the visibility squared data (from the OI_VIS2 tables) are read
in from all the tables within the file and associated with their respective target IDs as defined in the
Ol_TARGET table.

The “OI-FITS Data” sub-panel appears in the control panel allowing the user to select the data associated
with one or more individual targets from the file. The targets in the list can be selected contiguously by
clicking on the first desired target and while holding down the shift key, selecting the last target or
individually by holding down the control key and clicking (which toggles the selection on and off) on the
desired target.

OI-FITS Data

WR140
Select Target(s):\AR 140b

Remove Data

The OI-FITS data are displayed in the plot (plot tab), together with the simulated data. Note that some
observables listed in the “Plot Content Selection” X and Y Axis options may not exist or be derivable from
the contents of the file uploaded (depending on which of the OI-FITS optional tables are present); those
quantities will be disabled from the X and Y axis options in the “Plot Content Selection” menu.

In the Image Upload Mode, the u and v values of the data in the OI-FITS file are also overlaid on the
visibility modulus image (in the 2D Vis Modulus tab), together with the u and v values of the simulated
data.

Visibility Map
Uploaded Image: image_composite.fits

# NS +2003Jun.WR140 fits
250

225
20.0
17.5
15.0
12.5
10.0
225
5.0
25
0.0
25
5.0
7.5
-10.0
-12.5
-15.0
-17.5
200
225

-25.0
-25

V (cycles/mas)

U (cyclesimas)
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The “Remove Data” button removes the loaded OI-FITS data from the system. To reload the same data
or a new OI-FITS data set, the user needs to re-select the “Read OI-FITS File” option from the File pull-
down menu.

NOTE: The philosophy adopted by the VMT developers is that when the user has uploaded an OI-FITS
file, the contents of all the VIS and VIS? are plotted along with the simulated data. No attempt is made to
reconcile the parameters of a simulation with the contents of an OI-FITS file. Also, the VMT2 controls,
e.g. wavelength selection or HA coverage, only act on the simulated data, and do not filter the OI-FITS
data.

4.5.7 Image Tab

The “Image” tab (in “Upload Image” mode only) displays the uploaded brightness image. The tab
displays “No Image Available” in image upload mode before an image has been uploaded or after an
unsuccessful attempt to load an image (e.g. due to an incorrect FITS formatted file).

(‘Plot | Simulated Data | Instrument | FITS | Image | 2D Vis Modulus |

Brightness Image
Uploaded Image: image_composite.fits
North is Up, East is Left

4.0

n

3.5 : !
30 g TSSO NURUNS WIS WU SOONNEG SO . 1
25 ‘
2.0
1.5
1.0
0.5
0.0

[ (5

(5

Y (mas)

0.5

%

-1.0

n

-1.5
2.0
25
-3.0

(5

-3.5

v

4.0

40 35 30 25 20 15 10 05 00 05 10 15 20 25 30 35 40
X (mas)
xy=[-3.60, 3.95] Brightness=0.0000

’ Zoom In H Zoom Out ‘ ’ Gridlines ‘

While over the displayed image, the mouse is tracked and its x-y coordinates and associated brightness
value from the uploaded image are displayed at the bottom of the tab.

The “Zoom In” and “Zoom Out” buttons allow the user to zoom in and out respectively. When the limits of
the Zoom In and Out features have been reached, the respective button becomes disabled.

The “Gridlines” button shows/hides gridlines overlaid at the labeled axes tick marks.
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4.5.8 2D Vis Modulus Tab

The “2D Vis Modulus” tab (“Upload Image” mode only) displays the 2D visibility modulus for the uploaded
image, along with the uv values of the simulated data. The tab displays “No Image Available” in “Upload
Image” mode before an image has been uploaded or after an unsuccessful attempt to load an image (e.g.
due to an incorrect FITS formatted file, FFT processing error, etc.).

FITS Image rZD Vis Modulus |

Plot SARETEE O i Plot | Simulated Data | Instrument

Visibility Map el L

Uploaded Image: image_composite.fits e
" K1K2 0.250
0.225
0.200
0.175
0.150
0.125
0.100
0.075

FITS | Image | 2D Vis Modulus |

0.100 g 0.050 \\ -
0.025 \
0.075 E 0.000 \
% 0.050 S 0.025
£ 0.025 < 0050
E 0.000 -0.075
5 oo -
> 0.050 0.150
0.075 -0.175
2.100 0.200
-0.225
0.125 0.250
0.150 “7025 020 015 0.10 005 000 0.05 0.10 0.15 0.20 0.2!
0475 . U (cycles/mas)
0200 'L'“‘ﬁpn:“ﬁ'"
-0.225 S
-0.250 B
025 020 015 0.10 005 000 005 0.10 0.15 020 0.2! g R
U (cycles/mas) .25
uv=[0.0080,-0.229] Modulus=0.0049 o.c0 S - = oo ———cae
>
| Zoomin || Zoomout | | Gridiines || LineProfile | | Done |
Figure 4.5.8 A — Visibility Map Figure 4.5.8 B — Visibility Map with Line Profile

While over the map, the mouse is tracked and it's uv coordinates and associated visibility modulus value
are displayed at the bottom of the tab (figure A — Visibility Map). When the mouse is clicked within the
map image, the crosshairs “snap” to the closest simulated data uv point.

The “Zoom In” and “Zoom Out” buttons allow the user to zoom in and out respectively. When the limits of
the Zoom In and Out features have been reached, the respective button becomes disabled.

The “Gridlines” button shows/hides gridlines overlaid at the labeled axes tick marks.

The “Line Profile” button allows the user to specify two points on the modulus map (via mouse clicks) and
displays the profile in a two dimensional line plot (figure B — Visibility Map with Line Profile). The user can
press the “Done” button to return to the previous panel.
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4.5.9 Nuller Response Tab

The “Nuller Response Image” tab (“Upload Image” mode and only for the KI) displays the Nuller Beam
Pattern with the same pixel scale as that entered by the user upon uploading their (FITS) brightness
image. The tab displays “No Image Available” before an image has been uploaded or after an
unsuccessful attempt to load an image (e.g. due to an incorrect FITS formatted file).

FITS | Image | Nuller Response | FITS | Image | Nuller Response |
Pl Simulated Data I Instrument } Plot I Simulated Data [ Instrument
Nuller Response Image Nuller Response Image
Uploaded I image_t fits Uploaded Image: image.ud.fits
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Figure 4.5.9 A — Beam Pattern Figure 4.5.9 B — Beam Pattern with Overlaid Image

The user has the option to select the nuller beam pattern as calculated at the first, middle or last Hour
Angle observation points. In spectrometer mode, the user also has the option of choosing the shortest,
middle or longest wavelength.

The “Overlay Image” button allows the user to toggle between displaying the nuller response beam
pattern only (Figure A - Beam Pattern) or also super imposing the uploaded brightness (Figure B - Beam
Pattern with Overlaid Image).

While over the map, the mouse is tracked and it's x-y coordinates and associated Nuller Response value
are shown at the bottom of the tab.

The “Zoom In” and “Zoom Out” buttons allow the user to zoom in and out, respectively. When the limits
of the Zoom In and Out features have been reached, the respective button becomes disabled.

The “Gridlines” button shows/hides gridlines overlaid at the labeled axes tick marks.

28



VMT-2.0 User’s Guide NASA Exoplanet Science Institute
April 2009

5. Getting Help

For assistance with the VMT, you can:

1] reference our user’s guide http://nexsciweb.ipac.caltech.edu/vmt/vmtWeb/vmt-userguide.pdf
2] email us at help@ipac.caltech.edu with “VMT” in the subject, or
3] visit our help desk: http://nexsciweb.ipac.caltech.edu/cqi-bin/helpdesk/helpdesk.cqi
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A. File Formats

VMT Session File

Below is an example of the Target Model File that is used to save/load target models between sessions.
The file has a .vmt extension.

VERSION VMT_ 2.0

MODE 1

IMAGE_UPLOAD_PARAMETERS 0.0976 1

/Users/VMT/Examples/example.fits

INTERFEROMETER 0 0

INSTRUMENT_PARAMETERS 0.0200 5.0E-4

WAVELENGTH_PARAMETERS 2 1.3500 1.9500 3
OBSERVATION_PARAMETERS -3.0000 3.0000 15.0000

TARGET_MODEL_PARAMETERS 45.0000

TARGET 0 1 UniformDisc-001 0.0000 0.0000 0.5000 12.0000 3.0000 2.0000
TARGET 1 3 Gaussian-002 10.0000 10.0000 0.3000 28.0000 3.5000 3.2500
TARGET 2 0 Point-003 0.5000 0.8000 0.1000

TARGET 3 2 Uniform-Ring-004 3.4000 1.7000 0.1000 43.0000 3.2500 2.7500 1.0000

OI-FITS_FILE
/Users/VMT/Examples/example.oifits

The definitions of the fields are:
MODE [vmt_mode]

Vmt mode:
= 0 for Analytical Models Mode
= 1 for Upload Image Mode
IMAGE_UPLOAD_PARAMETERS [Pixel Scale]
Image_Upload_File_Pathname
INTERFEROMETER [Interferometer ID] [Selected Baseline IDs]
INSTRUMENT PARAMETERS [Visibility Squared Error] [Null Depth Error]

WAVELENGTH_PARAMETERS [Wavelength Option] [Center Wavelength]
WAVELENGTH_PARAMETERS [Wavelength Option] [Band Lower Limit] [Band Upper Limit]
WAVELENGTH_PARAMETERS [Wavelength Option] [Band Lower Limit] [Band Upper Limit] [Channels]

Wavelength Options:

= 0 for Monochromatic Option
1 for Broadband Option
2 for Spectrometer Option

OBSERVATION_ PARAMETERS [Hours Before Transit] [Hours After Transit] [Minute Increments]
TARGET_MODEL_PARAMETERS [Declination]
TARGET [Index][Type][Name][RAOffset][DecOffset][Flux][PA][OuterMajor][OuterMinor][InnerMajor]
*For Point Source Targets: PA, OuterMajor, OuterMinor and Inner Major fields are not
present

*For Gaussian and Uniform Disc: Inner Major field is not present

OI-FITS_FILE
OI-FITS_File_ Pathname
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Prediction Data File

Below is an example of the ASCII text Prediction Data File that can be easily imported into other
applications.

Date/Time : Mon Aug 18 15:29:11 PDT 2008
Interferometer: KECK

#

#

# Target Model

# Declination : 0.0
#

#

#

H

Image Upload Parameters

Image Name : No Image Uploaded
Pixel Scale : 1.0
rAngle Baseline U(m) V(m) Bp(m) ZA(degqg) PA(degq) V2(2.20) N(2.20)
-3.00 KI1K2 52.740 63.456 82.511 48.303 39.731 0.00000 1.00000
-2.75 KI1K2 53.960 63.456 83.296 44.987 40.376 0.00000 1.00000
-2.50 KI1K2 54.948 63.456 83.940 41.727 40.890 0.00000 1.00000
-2.25 KI1K2 55.702 63.456 84.435 38.539 41.277 0.00000 1.00000
-2.00 KI1K2 56.217 63.456 84.776 35.443 41.538 0.00000 1.00000
-1.75 KI1K2 56.491 63.456 84.958 32.466 41.677 0.00000 1.00000
-1.50 KI1K2 56.524 63.456 84.980 29.644 41.693 0.00000 1.00000
-1.25 KI1K2 56.314 63.456 84.840 27.026 41.587 0.00000 1.00000
-1.00 KI1K2 55.863 63.456 84.542 24.678 41.359 0.00000 1.00000
-0.75 KI1K2 55.173 63.456 84.088 22.684 41.006 0.00000 1.00000
-0.50 KI1K2 54.247 63.456 83.483 21.144 40.526 0.00000 1.00000
-0.25 KI1K2 53.088 63.456 82.735 20.164 39.916 0.00000 1.00000
0.00 KI1K2 51.702 63.456 81.852 19.827 39.172 0.00000 1.00000
0.25 KI1K2 50.095 63.456 80.846 20.164 38.289 0.00000 1.00000
0.50 KI1K2 48.273 63.456 79.730 21.144 37.262 0.00000 1.00000
0.75 KI1K2 46.245 63.456 78.519 22.684 36.083 0.00000 1.00000
1.00 KI1K2 44.018 63.456 77.228 24.678 34.748 0.00000 1.00000
1.25 KI1K2 41.603 63.456 75.878 27.026 33.250 0.00000 1.00000
1.50 KI1K2 39.010 63.456 74.488 29.644 31.581 0.00000 1.00000
1.75 KI1K2 36.250 63.456 73.080 32.466 29.737 0.00000 1.00000
2.00 KI1K2 33.334 63.456 71.678 35.443 27.714 0.00000 1.00000
2.25 KI1K2 30.276 63.456 70.308 38.539 25.507 0.00000 1.00000
2.50 KI1K2 27.088 63.456 68.996 41.727 23.117 0.00000 1.00000
2.75 KI1K2 23.784 63.456 67.767 44.987 20.547 0.00000 1.00000
3.00 KI1K2 20.378 63.456 66.648 48.303 17.804 0.00000 1.00000
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B. Algorithms

B.1. Spatial frequencies (u,v)

We use the baseline coordinates: Bup, Beast and Bnorth, to:

1) compute baseline in "XYZ" reference frame:

X =Bu * cos(l) - Bn * sin(l)

Y = Be

Z = Bu * sin(l) + Bn * cos(l)

Where:

| is the site latitude in radians (*pi/180 to convert from degrees). XYZ will be in meters.

2) compute u,v:

u= X *sin(ha) +Y * cos(ha)
v =-X*sin(d) * cos(ha) + Y * sin(d) * sin(ha) + Z * cos(d)

where:

ha = hour angle in radians (*15.*pi/180 to convert from hours).
d = target declination in radians (*pi/180 to convert from degrees).

So u,v will be in meters too.

The baseline coordinates [East, North, Up] currently used by the VMT are:
(please let us know if your interferometer’s baselines need to be updated!)

PTI: Latitude => +33.3567
PTI_NS =>[-37.116352,-103.264746,3.319338]
PTI_NW => [-81.685124,-28.214086,3.105647]
PTI_SW => [-44.566402,75.048984,-0.214424]

Kl: Latitude => 19.826667
KI_K1K2 =>[51.702317,67.455618,-0.003674]

NPOI: Latitude => +35.1933
NPOI_ANOACO =>[-0.1400,22.8500,0.0000]
NPOI_ANOAEO => [-17.6300,30.0900,0.0000]
NPOI_ANOAWO => [19.7500,32.7100,0.0000]
NPOI_ACOAEO => [-17.4900,7.2400,0.0000]
NPOI_ACOAWO0 => [19.8900,9.8600,0.0000]
NPOI_AEOAWO => [37.3800,2.6200,0.0000]
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NPOI_ANONOO => [-1.8300,16.5100,0.0000]
NPOI_ANONO1 =>[-1.580,14.300,0.000]
NPOI_ACONO0 => [-1.690,-6.340,0.000]
NPOI_ACONO1 => [-1.440,-8.550,0.000]
NPOI_AEONOO => [15.800,-13.580,0.000]
NPOI_AEONO1 => [16.050,-15.790,0.000]
NPOI_AWONOO => [-21.580,-16.200,0.000]
NPOI_AWONO1 => [-21.330,-18.410,0.000]
NPOI_NOONO1 =>[0.250,-2.210,0.000]

Latitude => +34.224383

CHARA W2S1 =>[-69.659,199.152,0.470]
CHARA W2S2 =>[-63.911,165.571,-0.174]
CHARA W2E1 =>[-195.001,-106.784,6.375]
CHARA W2E2 =>[-140.060,-70.565,3.258]
CHARA W2W1 =>[105.409,-17.170,11.298]
CHARA W1S1 =>[-175.069,216.322,-10.828]
CHARA W1S2 =>[-169.320,182.741,-11.472]
CHARA W1E1 =>[-300.410,-89.614,-4.923]
CHARA W1E2 => [-245.469,-53.395,-8.040]
CHARA E2S1 =>[70.401,269.717,-2.788]
CHARA E2S2 =>[76.149,236.135,-3.432]
CHARA E2E1 =>[-54.941,-36.219,3.117]
CHARA E1S1 =>[125.342,305.936,-5.905]
CHARA E1S2 =>[131.090,272.354,-6.549]
CHARA S2S1 =>1[-5.748,33.581,0.644]

Latitude => -24.6233

VLTI _U1U2 =>[24.31,51.08,0,0]
VLTI_U1U3 => [53.97,87.08,0,0]
VLTI _U1U4 =>[112.59,65.45,0,0]
VLTI_U2U3 => [29.66,36.00,0,0]
VLTI _U2U4 =>[88.28,14.37,0,0]
VLTI _U3U4 =>[56.62,-21.63,0,0]

Latitude => -30.3223
SUSI_N1S1 =>[0, -5.0, 0]
SUSI_N1S2 => [0, -10.0, 0]
SUSI_N3S1 => [0, -15.0, 0]
SUSI_N3S2 => [0, -20.0, 0]
SUSI_N1S3 => [0, -30.0, 0]
SUSI_N3S3 => [0, -40.0, 0]
SUSI_N4S1 => [0, -55.0, 0]
SUSI_N4S3 => [0, -80.0, 0]
SUSI_N1S4 =>[0,-110.0, 0]
SUSI_N4S4 =>[0,-160.0, 0]
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B.2. Visibility Equations — Analytical Models

Approximations: In this release we base our calculations on the van Cittert-Zernike theorem, which
relates the complex visibility to the brightness distribution on the sky by a two-dimensional Fourier
transform, representing each telescope by a delta-function (i.e. we do not consider the actual antenna
pattern of each telescope), and neglecting other apodizing functions such as those produced by coupling
into single-mode fibers, often used to clean up the incoming wavefronts.

The elementary morphologies used in this release are intended to represent 2D surface brightness on the
sky. Their visibility functions are therefore also 2D. Moreover, the elementary components need not be
circularly symmetric; they can be elliptical and with any orientation on the sky (some astronomical objects
are approximately elliptical on the sky, such as the disk of a fast rotating star, while other objects, such as
a uniform disk, appear elliptical when they are inclined to the line of sight).

The formulae below are based on the following properties: (1) any circularly symmetric brightness has a
Fourier transform (visibility) that depends on only one variable, sometimes referred to as the "fringe
spacing": s=sqrt(u*2+v*2)/wavelength; (2) the ellipticity (uniform or Gaussian) can be taken into account
by a coordinate transformation starting from the formulae for symmetric brightness, with the result that the
same formulae can be used provided we replace s by:

s'=s'(u,v;phi,a,b)=s*sqgrt(cos*2(theta-phi)+(b/a)*2*sin*2(theta-phi))
where:

s=sqrt(u*2+v*2)/wavelength

theta = baseline position angle = atan(u/v); measured East of North.
a = angular dimension of ellipse major axis.

b = angular dimension of ellipse minor axis.

phi = ellipse major axis position angle, measured East of North.

u and v are the components of the projected baseline vector (in meters) . The wavelength of observation
must be in same units as u and v (meters).

Note: the elliptical brightness can be thought of as resulting from tilting a circularly symmetric brightness
by angle i, such that cos(i)=b/a. i=0deg recovers the face-on morphology.

The user is also allowed to place each component anywhere on the sky by specifying right ascension and
declination coordinate offsets X0 and YO with respect to the center. Optical interferometers usually track a
bright compact object located at this phase center (X0=0,Y0=0). If we call V(s') the visibility function for
one of the basic components, then (by the shifting property of the Fourier transform) the coordinate
offsets simply introduce the (complex) multiplicative factor: exp(-2*pi*i*(X0*u+Y0*v)). The ability to place
any number of elementary models arbitrarily on a map will allow the user to better approximate the
morphology of an object of interest as a composite model. Each model component is specified to
contribute a fraction (f) of the total flux in the composite object. When composing their source models,
users must be mindful that interferometers have field of view limitations.
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Below we give the monochromatic analytical expressions for the elementary complex visibilities:

(The parameters of sky locations and angular sizes X0,Y0,a,b, and phi are internally converted from the
user input units to radians).

Point Source

Inputs:
f: flux fraction (of total) (dimensionless)
X0, YO offsets (input in mas)

V(s') = V(s) = V(u,v;f,X0,Y0) = f * exp(-2*pi*i*(X0*u/wavelength+Y0*v/wavelength))
Uniform Disk

Inputs:
f: flux fraction (dimensionless)
X0, YO offsets (mas)
a: angular diameter along major axis (mas)
b: angular diameter along minor axis (mas)
phi: position angle of ellipse major axis, East of North (degrees)

V(s') = V(u,v;phi,a,b,f,X0,Y0) =
=f*2* J1 (pi*a*sl)/(pi*a*sl) * eXp(—2*pi*i*(X0*u/Wave|ength+Y0*VlwaveIength))

where J1 is the 1st order Bessel function.
Gaussian

Inputs:
f: flux fraction (dimensionless)
X0, YO offsets (mas)
a: angular diameter along major axis (mas) (FWHM)
b: angular diameter along minor axis (mas) (FWHM)
phi: position angle of ellipse major axis, East of North (degrees)

V(s') = V(u,v;phi,a,b,f,X0,Y0) =
= f * exp[(-pi*2*a2*s'"2)/(4*Ln(2))] * exp(-2*pi*i*(X0*u/wavelength+Y0*v/wavelength))

where Ln is the natural logarithm.
Uniform Ring
Inputs:

f: flux fraction (dimensionless)

X0, YO offsets (mas)
al: angular inner ring diameter along major axis (mas)
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b1: angular inner ring diameter along minor axis (mas)

a2: angular outer ring diameter along major axis (mas)
phi: position angle of ellipses major axis, East of North (degrees)

V(s') = V(u,v;phi,a1,b1,a2,f,X0,Y0) =
=f*[a2/2 * J1(pi*a2*s')/s' - a1/2 * J1(pi*al1*s')/s')/(pi/4*(a2”2-a172)) *
* exp(-2*pi*i*(X0*u/wavelength+Y0*v/wavelength))

Note: as before, s' accounts for the ellipticity through the aspect ratio (b1/a1)=(b2/a2); hence only b1 or
b2 is required as an input parameter, but not both.

Visibility for the Composite Model

If we call V(s')_i the normalized visibility function for each (possibly offset) basic component as given
above, the final (complex) visibility will be:

V(s') = Sum[V(s")_i]

Finally, the visibility modulus (squared) equals the product of the above complex visibility and its complex
conjugate:

IV(s')"2 = V(s') * V*(s')
or equivalently:

[V(s")|"2 = Re(V)"2+Im(V)"2
where Re and Im denote the real and imaginary parts of the complex visibility.
Kl Null

Ignoring details of the KIN beam pattern on the sky (specifically, due to (1) the half-circle shapes of the
K1 and K2 pupils that produce the long baseline fringes, and (2) the short-baseline cross-fringes used for
thermal background modulation), the null depth may be approximated as:

N=(1-[V)/(1+|V])

where |V| is the visibility modulus for a single-component or composite model, computed as described
above. The above formula is a good approximation provided the short baselines (~5 m, or ~400 mas
fringe spacing) do not significantly resolve any component of the object’s brightness distribution.
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B.3. Numerical Algorithms — Image Upload

B.3.a. Visibility

Visibility modulus (and visibility squared) is computed from a 2D FFT of the user input image. Bilinear
interpolation is used to obtain the visibility at the uv points that correspond to the user’s selection of an
interferometer/baseline(s) and HA coverage.

In the current version, the VMT is limited to images of at most 512x512 pixels in size, unless the JVM
memory is increased by the user as describe in Section 3 of this manual.

An important consideration for the accuracy of the FFT-based results is that of zero-padding. Users are
advised to create images that contain their brightness region of interest surrounded by an area ~x4 as big
filled with zeroes, in order to be immune to the effects on the FFT of the square-shaped support for the
image.

The uploaded images are assumed to be monochromatic, computed at the wavelength entered by the
user in the Wavelength Parameters Panel.

As is also the case for the calculations of the Analytical Mode, broadband and spectrometer calculations
only reflect the effects of wavelength on the spatial frequencies u and v, and not any wavelength
dependence of the brightness itself. In that sense, the broadband and spectrometer calculations will be
strictly correct only for grey emission.

As was described earlier, the VMT always displays the uploaded images and 2D visibility maps with
North=Up and East=Left, following standard convention in astronomy. The input image is by default
assumed to be oriented East=Left. However, the user can flip the input image left-to-right from within the
tool via a checkbox in the Preferences tab.

B.3.b. Kl Nuller

In Image Upload mode, the Kl Null Depth calculation includes, in addition to the long baseline Keck-Keck
fringes, two additional terms of the KI Nuller beam pattern: the projection on the sky of the split-aperture
pupils of each Keck, and the wide (a.k.a. “cross-combiner”) fringes formed using the two halves of each
Keck (which are used for signal modulation in the presence of the strong infrared thermal background).

Therefore, the Kl Nuller beam pattern is the product of three images:

T(x,y): the single telescope patterns.
B_xc(x,y): short baseline fringes.
B_long_peak(x,y) or B_long_null(x,y): long baseline fringes at peak or at null.

Where (x,y) represent angular sky coordinates. The peak and null signals are computed by multiplying,
pixel by pixel, the appropriate product of three beam pattern images by the user uploaded input
brightness image I(x,y):

e Peak_signal = Sum_x,y[I(x,y) * T(x,y) * B_xc(x,y) * B_long_peak(x,y)]
e Null_signal = Sum_x,y[l(x,y) * T(x,y) * B_xc(x,y) * B_long_null(x,y)]
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Finally, the normalized null depth, or leak, is computed as the ratio of the null to peak signals:
e Null_Depth = Null_signal/Peak_signal

As described above for the visibility calculations, broadband and spectrometer null depth calculations only
reflect the effects of wavelength on the spatial frequencies u and v, and not any wavelength dependence
of the brightness itself. In that sense, the broadband and spectrometer calculations will be strictly correct
only for grey emission.

Each of the Kl Nuller beam pattern terms is computed as follows:

Telescope pattern:

The PSF that correspond to each Keck’s half-pupils can be modeled as an elliptical Gaussian, with minor
axis always pointing to toward zenith:

T(x,y) = exp(-0.5 * z)

with:

z = (xr/sigma_major)*2 + (yr/sigma_minor)"2

xr = x * cos(theta) - y * sin(theta)

yr = x * sin(theta) + y * cos(theta)

sigma_major = fwhm_major / (2.*sqrt(2.*alog(2)))
sigma_minor = fwhm_minor / (2.*sqrt(2.*alog(2)))
fwhm_major = 0.45 arcsec

fwhm_minor = 0.31 arcsec

The angle theta determines the orientation of the elliptical Gaussian on the sky as a function of H.A., as
described below.

Cross-combiner fringes:

The short baseline fringes formed by interfering the half-pupils of each Keck have a constant ~4m
baseline (because each telescope tracks the object), hence:

B_xc(x,y) = cos(2.*pi*(x*uxc + y*vxc)/wavelength)

Where uxc and vxc are the East and North components of the short baseline (in meters), which also must
take into account the image rotation, as described below. Note that the telescope pattern and cross-
combiner fringes rotate together, but their orientation with respect to the long baseline fringes varies as a
function of H.A.

Long baseline fringes
At peak:

B_long_peak(x,y) = 1 + cos(2.*pi*(x*u + y*v)/wavelength)
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At null:

B_long_nuli(x,y) = 1 - cos(2.*pi*(x*u + y*v)/wavelength)
where u and v are the East and North components of the Keck-Keck baseline (in meters).
Image rotation

The Keck telescopes have alt-az mounts. An image rotator keeps the split-pupils fixed on the Adaptive
Optics wavefront sensor. Hence the PSF and cross-combiner (short baseline) fringes rotate together as a
function of H.A., with the elliptical single telescope pattern minor axis always pointing toward zenith. The
orientation of the long baseline fringes inside this ellipse is given by the u and v components of the Keck-
Keck baseline. The orientation of the PSF and cross-combiner fringes is given by the following equations
(many thanks to Mark Kuchner):

Length of cross-combiner baseline (m):
Bxc_length = 4.

PA of cross-combiner baseline (deg):
PA_xc=90.0

sin and cos of position angle of mirror:
sinPA=sin(azimuth)*cos(latitude)
cosPA=sqrt(1.0-sinPA"2)

cross-combiner baseline component if the short baseline were at PA=0 on the mirror (vertical when the
altitude is zero):

uvert=Bxc_length*sinPA
vvert=Bxc_length*cosPA

rotate to take into account the actual orientation of baseline on the mirror:

uxc=cos(PA_xc)*uvert + sin(PA_xc)*vvert
vxc=-sin(PA_xc)*uvert + cos(PA_xc)*vvert

and the angle theta above in the rotation of the elliptical telescope pattern is:
theta (deg) = atan(uxc/vxc) * 180/pi + 270.
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C. Acronyms / Glossary

Bp
CHARA
Dec
degs
FFT
FITS
GUI
HA
JAR
JDK
JRE
Kil
mas
MA
MID
MSC
ND
NExScl
NPOI
OI-FITS
PA
PSF
PTI
RA
SUSI
TBD
TBS
ubD
UR
V2

V
VMT
VLTI
ZA

Projected Baseline Length

Center for High Angular Resolution Array
Declination

Degrees

Fast Fourier Transform

Flexible Image Transport System
Graphical User Interface

Hour Angle

Java Archive File

Java Development Kit

Java Runtime Environment

Keck Interferometer

milliarcseconds

millions of wavelengths

mid-infrared

Michelson Science Center

Null Depth a.k.a. Leakage

NASA Exoplanet Science Institute (formerly MSC)
Navy Prototype Optical Interferometer
Optical Interferometry FITS

Position Angle

Point Spread Function

Palomar Testbed Interferometer
Right Ascension

Sydney University Spatial Interferometer
To Be Determined

To Be Supplied

Uniform Disc

Uniform Ring

Visibility Squared

Visibility modulus

Visibility Modeling Tool

Very Large Telescope Interferometer
Zenith angle
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